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Foreword
Information in this documentation is subject to change without notice and does not bear 
any commitment on the part of I.R.I.S.

 

The software described in this document is furnished under a license agreement which 
states the terms of use of this product. The software may be used or copied only in 
accordance with the terms of that agreement.

No part of this publication may be reproduced, transmitted, stored in a retrieval system, 
or translated into another language without the prior written consent of I.R.I.S.
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System Requirements
The minimum required specifications to run Readiris PDF are:

 

Software requirements

Component Requirement

Computer and processor 1.2 GHz processor or higher

Memory 4 GB RAM or higher

Available hard drive space 5 GB or higher

Operating System Windows 10,  64-bit

Other Internet connection

 

Hardware requirements
For compatibility with scanners, go to Configure your scanner

 

Caution: small form factor PCs or virtual machines may not be 
compatible



Readiris PDF

                                                                                                       5 of 68 

Download and Install
Before you try and install Readiris PDF, make sure you have the necessary administrator 
rights to install applications on your computer.

 

Download on Windows Computer
Visit www.irislink.com to download Readiris PDF

 

Install Readiris PDF

 

Tip: Run the installer from your local drive. Running the installer from a 
virtual or an external drive may display Microsoft security messages.

Double click the executable installation file (.msi) to start the Installation Wizard1

Follow the on-screen instructions to finish the installation.2

https://www.irislink.com/
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Activate Readiris PDF
Once you have installed Readiris PDF, you need to activate it.

 

Two types of activation are available: with a Product Key or via User Registration. 

Note: An Internet connection is required!

 

With a Product Key

The information about your license on the right panel is refreshed.

 

Deactivation

To reuse the same Product key on another computer, you must first deactivate it on 
your current computer (one active use at a time). 

Once confirmed, it is ready to reuse. 

 

Via User Registration
If you wish to benefit from the 'activation anywhere', create an account with the IRIS 
Cloud solution (IRISPulse). 

Already have an IRISPulse account? 

In Readiris PDF, the information about your license on the right panel is refreshed.

Go to File Menu   > Activation1

Enter your Product Key (22-character code) in the Activation code Panel2

Click on Online activation3

Copy and paste the current Product key in the Activation code Panel1

Click on Online deactivation2

Click on Sign in.  You are redirected to the IRISPulse Authentication page.1

Enter your credentials (you receive a user token).2

Your available products are displayed in a list.3

Activate the product you want to use.4
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Note: When your token has expired, a new authentication will be 
required  

 

You don't have an IRISPulse account? (Coming soon)

 

Click on Register. You are redirected to the IRISPulse Registration page  1

Click on Register to create a new user account and receive a free 30-day trial version 
in your account

2

Once your account is created, start the Sign in procedure3
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Open Readiris PDF
Double-click the Readiris PDF icon on the Desktop to launch the application.

 

Exit Readiris PDF

OR

 

Go to the upper-right corner of the title bar1

Click on the Close button 2

Go to File Menu  1

Select Exit the application 2
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Navigate the interface
Readiris PDF offers you two menu modes: an office-style Ribbon and a Modern Menu
based on a input-process-output workspace.

What is a concept of Input -> Process -> Output? 

It is an intuitive workspace divided into 3 main areas:

At any time, you can toggle between office-style Ribbon or Modern presentation by 
pressing F12.

 

Tip: When hovering the pointer of your mouse on an icon or a button, a 
tooltip appears, giving you information about the item.

 

 

Input Area
The upper left area of the interface is dedicated to Inputs.

You can find more detailed explanations about this panel in the Import chapter.

on the upper left, you import and set the document(s) on which you want to work,•
in the center, you process and edit,•
on the upper right, you set your output and export your result.•
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Process Area
The central area and its full workspace just below are dedicated to processing 
documents.

 

The features icons bar (main menu) contains all the possible actions/processes to 
perform on your documents.
In the Preferences, you can choose to display those actions in a classical Ribbon 
mode.
You can find more detailed explanations on each feature in the Process chapter.

1.

The Tab bar allows you to see which document is currently open for processing, and 
to rename a document by right-clicking on the title or by pressing F2.

2.

The main Viewer allows you to process your document and view your actions. 3.

The semi-transparent Viewer Toolbar allows you to:

Icon Description

Previous/
Next page

Move through pages 

Toggle Single 
page/Multi-
page View

Switch from single page view to multi-page view.

The single page view allows you to visualize the page objects 
(zones and annotations) and to edit the page. 

The multi-page view allows you to organize your pages.  By right-
clicking on a page, you access the cut, copy, paste, split, 
merge and delete options. You can zoom in or zoom out with 
Ctrl+mouse wheel. You can reorder pages with drag and drop or 
cut, copy and paste.  You can select multiple pages with 
Ctrl+click. (see Keyboard shortcuts for further options).

Selection tool
Select objects on the page or draw areas on the page with your 
mouse cursor.

Move
Move around the page following your mouse cursor (similar to 
scrolling up or down as well as left or right at the same time)

Zoom 
in / zoom out

Define the display of your page (in percentage): use the buttons 
+/- OR type in a number OR use the shortcut Ctrl+ mouse wheel.  
On a tablet, use your thumb and index on the touchpad and pinch 
in or stretch out

4.



Readiris PDF

                                                                                                       11 of 68 

 

Output Area
The upper right area of the interface is dedicated to Outputs.

You can define the settings of format and destination of your exports.

You can execute your exports (cf. Save button). 

You can find more detailed explanations about this panel in the Export chapter.

 

Note: You can show or hide the thumbnail, object and properties panels 
by clicking on the show/hide arrow  .  

 

File menu
The File Menu  opens a navigation rail. 

Icon Description

Info. Gives you information about this software (version, serial number)

Open. Allows you to open a document from Files, Scanner or Clipboard (cf. 
Import) and shows you the recently opened documents.
Also, gives you access to several actions via shortcuts: create PDF, edit and 
modify, convert PDF, annotate and comment PDF, combine PDF, batch 
processing, Help Quick Tour.

Save. Allows you to save your active document to various destinations (local 
computer, email, Cloud) and includes shortcuts to convert to other formats.

The Thumbnail panel (dynamic panel) allows you to preview the pages of your 
document (in single page view only). By right-clicking on a thumbnail, you access the 
cut, copy, paste, split, merge and delete options (see compose features). You can 
zoom in or zoom out with Ctrl+mouse wheel. You can reorder pages with drag and 
drop or cut, copy and paste.  You can select multiple pages with Ctrl+click. (See 
Keyboard shortcuts for further options).

5.

The Object panel (dynamic panel) associated with the Properties panel (dynamic 
panel) allows you to visualize and control the objects present at document level
(document properties, PDF bookmarks, PDF attachments) or at page level (page 
properties, OCR languages, page zones, stamps, PDF annotations, PDF forms). You 
can customize the display thanks to the slide button show/hide.  The Object panel is 
available in single page view only. 

6.

The Search box in the Title bar allows you to search and find text in the active/
current document. Go to How to search and replace for more details.

7.
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Save as... Opens the File Explorer to save your document locally.

Close document. Closes the current active document.

Share. Gives you access to your favorite shared destinations via shortcuts (Email, 
Cloud)

Print. Starts printing the current active document. For Printer settings, go 
to settings per destination

User Settings. Allows you to set your preferences

Activation. Allows you to activate this software

Update. Allows you to search for updates

Help. Opens the User Guide

Exit the application
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Preferences

 

User Interface
Light or dark mode

By default, the light mode is on. 

Click on the slide button to switch to the dark mode. 

 

Ribbon or Modern presentation

By default, the Ribbon presentation is on. The groups of commands are displayed in a 
classic Ribbon (with tabs). 

However, the same groups of commands can be displayed in an icon bar, which is called 
the Modern mode.  This documentation is mainly based on the Modern presentation, to 
help you familiarize with it.  Tooltips help you to understand the icons. 

Click on the slide button to switch to Modern mode. You can also press F12 to toggle 
between the two modes.  

Modern 
mode

 

Ribbon mode

 

Remember session

By default, your workspace (active tabs) is not remembered at closing of the application. 
When starting again, go to File Menu > Open > Recent documents to reopen your latest 
documents, or, to save your workspace at each closing, click on the slide button to 
activate the Remember session option. 

 

Go to File Menu  1

Select User Settings   2
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Change the interface language

Select your interface language within the 'Languages' drop down list.

Legal Notice
By default, the Usage Intelligence is on. 

Click on the slide button to switch it off. 

 

OCR Settings
Favor text over layout

The default OCR settings favor the layout over the text. This means the result after 
recognition will be as close as possible to 'what you see is what you get'. 

However, you can choose to favor text over layout (click on the slide button to switch 
mode).  By doing so, Readiris PDF will give the focus on the text and therefore might give 
a different result of what you see.  

 

Automatic Language Detection (ALD)

Note: By default, the Automatic Language Detection is switched on and 
excludes manual settings. 

 

 

Readiris PDF can detect the main OCR language automatically.  The aim of this feature is 
to automatically detect the most probable language on a page.
The Object Panel shows the detected language at page level. Cf. The page Properties in 
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the Properties panel.  There you can modify the OCR language easily and even add two 
additional OCR languages (e.g. for documents mixing languages).  You can apply those 
settings to all pages at once by clicking Apply to all pages.

 

ALD supported languages 

English, German, French, Spanish, Italian, Swedish, Danish, Norwegian, Dutch, 
Portuguese, Galician, Icelandic, Czech, Hungarian, Polish, Romanian, Slovak, Croatian, 
Slovenian, Finnish, Turkish, Estonian, Lithuanian, Latvian, Albanian, Catalan, Irish Gaelic, 
Scottish Gaelic, Basque, Indonesian, Malay, Swahili, Tagalog, Haitian Creole, Kurdish, 
Cebuano, Ganda, Kinyarwanda, Malagasy, Maltese, Nyanja, Sotho, Sundanese, Welsh, 
Javanese, Azeri (Latin), Uzbek, Bosnian (Latin), Afrikaans.

Serbian, Russian, Belarusian, Ukrainian, Macedonian, Bulgarian, Kazakh.

Greek. 

Hebrew.

Arabic, Farsi.

Traditional Chinese, Simplified Chinese, Japanese, Korean. 

 

Note: Similar variations of a main language are assimilated. E.g. Spanish 
assimilates all variations of Spanish, Portuguese assimilates Brazilian or 
French assimilates all variations of French.

 

Manual setting

 

Switch off the Automatic language detection (ALD) by clicking on the slide button 
next to it. 

1

Select manually an OCR language from the OCR Languages drop down list. 2
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Import documents
With Readiris PDF you can open or scan a various number of file formats and use them 
as input. 

 

Supported input specifications

Input type Specifications

Resolution  from 96 to 1200 DPI

PDF versions

PDF 1.3, 1.4, 1.5, 1.6, 1.7

Extension Level 3 (AES encryption)
Extension Level 5 (XML Form Architecture)

iHQC - PDF compressed (all levels) (from I.R.I.S)

Image formats JPG, JPEG, JPG2000, TIF, TIFF, BMP, PNG

MS Office formats .DOC, .DOCX, .XLS, .XLSX, .PPT, .PPTX

 

Warning: For a correct image handling and processing, make sure your 
image size does not exceed 75 megapixels

Tip: To configure your input settings, go to Configure input settings.

 

Open from local files

Or simply drag and drop a file from the File Explorer.

 

Import pages from a scanner

In the input area, click on Open    or press F51

The File Explorer opens, select your file to import2

Click Open3

In the input area, click on Scan   or press F41
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•

•

 

Create a new document or append to current document
A slide button  allows you:

to import more files by creating a new document (create in a new document)  .  
This is the default setting. Then when you import from a scanner, a pop-up window 
opens asking you to name the new document. Once the name is confirmed, the 
scanning is launched. A new tab is created for each new document in the tab bar.

OR

to import more files into the current document (append to current document)  . 
The imported pages are added to your current document. You can see them in the 
thumbnail view. 

 

Notes:

 

On The Fly Operations

The button  allows to activate or deactivate the 'On The Fly' operations when 
importing.

By default, this option is disabled.  When enabled, you can define those On The Fly
operations in the settings of each input source.

 

Import from Clipboard
You can import content from your clipboard thanks to the Ctrl-V shortcut.   This can be 
done into an existing document or into a new document.

The first time, a pop-up window opens for you to select your source scanner.  Once 
your source is selected, clicking on the Scan button will launch the scanning

2

You can Rename the title of your document by right-clicking on the 
tab title or by pressing F2.

•

If the check box 'Use file name' is checked in the input settings, 
then importing a local file as a new document will reuse the same 
file name for your imported document.

•

In the Ribbon mode, go to tab Home > Capture. 

 

•
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For an existing document: 

 

For a new document,

 

Open an existing document.1

In the thumbnail panel (or multi-page view), select with your mouse cursor the 
place (between pages - red line) where you want the new page to be created.

2

Press Ctrl-V or right-click your mouse and select Paste (Paste Before or After if you 
right-clicked on a page). 

3

A new page is created in your document with your clipboard content. 4

Create a new document by pressing the plus sign ( ) in the tab bar.1

Enter a document name. Click OK.2

Press Ctrl-V.3

The clipboard content is pasted in your new document. 4
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Configure input settings
 

Configure your local folder 

 

Configure your scanner 
Readiris PDF is compatible with: 

TWAIN
It supports almost any flatbed and sheet-fed scanner, all-in-one 
device, digital camera and scanner currently available

32-bit drivers It supports 32-bit scanners only!

Simplex & 
Duplex

Scanners that offer duplex scanning are supported

USB  Scanners with USB plugin are supported

 

 

On The Fly Operations
Whether you are opening a file or scanning a document, you can define 'On The Fly' 
Operations.  

Four image processing operations are available: 

In the input area, click on the Option menu   (Input settings) below the Open 
button . A window opens.

1

Define the file format you want to consider for importing.2

Check the box 'Use file name' if you want to reuse the same name for your imported 
document.

3

In the input area, click on the Option menu   (Scan settings) below the 

Scan button  . A window opens.

1

Select your scanner from the drop down list.  All the available scanners (i.e. 
connected to your computer) have been detected. 

2

Delete blank pages•
Auto-rotate pages•
Deskew pages•
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Select the operations you want to be executed while opening a file or scanning a 
document.  Combinations are allowed. Be aware however that the more operations you 
select, the more time the opening or the scanning will take.

 

Note: In the Ribbon mode, go to tab Home > Capture. Clicking on the 
small down arrow besides the From File button or besides the From 
Scanner button opens the settings windows. 

 

 

Remove black borders•
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Process image
Image processing features  aim to obtain the best possible scan results. The higher 
the quality of the scans, the higher the recognition accuracy.

 

In the Ribbon mode, go to tab Edit > Image Processing to find the image processing 
features.

Some image processing features listed below require setting properties. Thus, a 
Properties panel opens if applicable.  

In the Properties panel, you can modify, apply or cancel your settings

 

Icon/tooltip Description Properties

Auto-rotate
Auto-rotate rotates images 
automatically

 

Rotate 90° Rotate 90° clockwise  

Rotate 180°    

Rotate -90° Rotate 90° anti-clockwise  

Deskew
Deskew aligns a scanned image 
horizontally to compensate for 
skewing

 

Contrast 
brightness

Adjust the contrast and the 
brightness levels to color or 
grayscale images

Grayscale
Grayscale converts color images 
into grayscale images

 

Brightness slider: optimizes 
the intensity of light

•

Contrast slider: optimizes 
the distinction between 
lighter and darker areas

•

Gamma slider: gamma 
optimizes the contrast and 
brightness in the midtones

•
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Binarize
Binarize turns color and grayscale 
images into binary (black-and-
white) images

Negative
Negative inverts the colors of the 
scanned documents

 

Crop

Crop the image by defining an 
area.

Once the cropping is applied, 
you cannot come back to the 
original image. You will need to 
import or scan it again.

Click Cancel to remove your 
cropping selection (before 
applying) and close the 
Properties panel

 

Remove black 
borders

Remove black borders (or dark 
surroundings) 

Remove punch 
holes

Remove black punch holes from 
your page 

 

Perspective 
correction

Correct the perspective distortions 
of your page (3D correction)

Brightness slider: optimizes 
the intensity of light

•

Contrast slider: optimizes 
the distinction between 
lighter and darker areas

•

Smoothing slider: it removes 
noise from the scans. The 
higher the value, the higher 
the removal

•

Click on Crop.  The 
Properties panel opens. 

•

Click the mouse and draw a 
box around the section you 
want to crop.

•

Drag and drop the box where 
you want and resize it 
according to your needs.

•

Click Apply in the Properties 
panel. 

•

Border: 1 (low), 2 (medium), 
3 (high)

•

Crop to a selected area of 
the image: tick the box to 
enable the cropping

•

Automatic crop•
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Downscale Reduce the size of your page

Text Removal

Remove all recognized text 
zones (on single page view).

For more information 
on recognition zones. go 
to Page Analysis. 

Downscale percentage 
(from 100% to 1%)

•

Go to the Object Panel to 
show the zones (slide 
button).  Text zones are 
identified in blue. 

•

Remove the text zones for 
the text you want to 
keep: select text zone, right-
click+Delete.

•

Click on Text removal.  
The text of the remaining 
zones is removed. 

•

Type: normal, best quality or 
fast

•

Dilate the text area in pixels 
(from 0 to 10)

•

Radius of the Inpainting
(from 0 to 15)

•



Readiris PDF

                                                                                                       24 of 68 

Compose
Compose features   allow you to organize your document.

 

In the Ribbon mode, go to tab Compose to find the compose features.

Some Compose features listed below require setting properties. Thus, a Properties 
panel opens if applicable.  

In the Properties panel, you can modify, apply or cancel your settings.

 

Icon/
tooltip

Description Properties

New 
document

Create a new document
 

Split 
document

 

Merge 
documents

 

Click on New document•
Enter a document name. Click OK.•
Open the document you want to split•
Select the page from which you want a 
split to occur (it will include that page 
and the next ones). Use thumbnail 
panel or multi-page mode.

•

Click on Split•
Enter a name for the new document to 
be created

•

The new document is created and 
contains the split content

•

Open the document you want to 
merge

•

Click on Merge•
Choose the Document name you want 
to merge into

•

Check the box Merge on top if you 
want your document to be inserted 
before (by default, it is inserted after)

•

Click OK•



Readiris PDF

                                                                                                       25 of 68 

Insert 
document

Insert a document from file only

To insert a page/document from a 
scanner, use the Append feature. 

 

Blank page
The blank page is the same size as the 
previous page. If you start your document 
with a blank page, then by default an A4 is 
created.

 

Extract 
document

Extract page(s) out of your current 
document.  Extracted pages are not 
removed from the current document. 
They are copied into a new document. 

 

Cut
Cut the selected page(s) and copy to 
clipboard (Ctrl+X)

 

The first document is added into the 
second one (on top or at the end 
according to your choice)

•

Open the document in which you want 
to insert another one (or more)

•

Click on Insert. The import file dialog 
opens 

•

Select one or more files•
Click OK•
The selected file is added into the 
current one

•

Select a page (from thumbnail panel or 
multi-page view)

•

Click on Blank page•
A blank page is inserted after the 
selected page

•

Open the document from which you 
want to extract one or several pages.  
Select the pages to be extracted (cf. 
thumbnail panel or multi-page view).

•

Click on Extract•
Choose the Document name for your 
new document

•

Click OK•
A new document is created out of your 
extracted pages

•
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Copy
Copy the selected page(s) and copy to 
clipboard (Ctrl+C)

 

Paste
Paste the content of the clipboard (Ctrl+V, 
paste after per default)

 

Delete 
pages

 

 

Tip: From the thumbnail panel or from the multi-page view, you can:

 

Select the page(s) you want to delete 
(from thumbnail panel or multi-page 
view)

•

Click on Delete pages•
A confirmation box appears: click yes 
or no

•

reorder pages by dragging and dropping•
cut, copy, paste, split, merge and delete pages by right-clicking on a 
thumbnail or a page

•
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Comment
Comment features   allow you to annotate your document. 

 

Caution: for most of the annotations to appear on your exported 
documents, the output format must be a PDF. 

 

In the Ribbon mode, go to tab Comment to find the annotation features.

Some Review features listed below require setting properties. Thus, a Properties panel
opens if applicable.  

In the Properties panel, you can modify and apply your settings. 

 

Options

Icon/tooltip Description Properties

Stamp (rubber 
stamp)

Add pre-defined stamps (e.g. 
'Approved' or 'Draft')

To customize or to create 
your own stamps, use the 
Properties panel.

Click on Stamp.  The 
Properties panel opens. 

•

Select the stamp of your 
choice from the list.

•

Click on the page.  The 
stamp is displayed.

•

Drag and drop the stamp 
where you want, resize 
or rotate it according to 
your needs

•

Create a new stamp by clicking 
on the + button

•

Remove a stamp from the list by 
selecting it and then clicking on 
the - button

•

Text to display (e.g. Confidential)•
Add metadata such as author, 
date, time-stamp

•

Font type•
Font color•
Border type: no border, square, 
rounded square, left arrow

•
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Draw

Draw various shapes on the 
page. 

Signature

Add a stamp of digital 
signature. 

The signature stamp is 
displayed in one location, 
but the signature is global 
for the document. 

Comments and 
Sticky notes

Add a small text or a 
comment/sticky note to your 
page.

Click on Draw.  The 
Properties panel opens. 

•

Select the shape of your 
choice. 

•

Draw the shape on the 
page. The shape is 
displayed. 
For Polygon and 
Polyline, draw line 
segments with your 
mouse (one-click each), 
then double-click when 
your shape is finished.

•

Fill in the Properties.•
Drag and drop the 
drawing where you want 
and resize it according to 
your needs

•

Rectangle: select border color, 
background color, border pattern 
(dash), border thickness and 
opacity.

•

Circle: select border color, 
background color, border pattern 
(dash), border thickness and 
opacity.

•

Straight line: select color, dash 
pattern, thickness and opacity of 
the line. Check the right box to 
add an arrow at the start or at 
the end of the line. 

•

Polygon:  select border color, 
background color, border pattern 
(dash), border thickness 
and opacity.

•

Polyline: select color, dash 
pattern, thickness and opacity of 
the polyline. Check the right box 
to add an arrow at the start or at 
the end of the line. 

•

Click on Signature•
Click on the page. The 
stamp box is displayed. 
The Properties panel
opens. Thanks to the 
move cursor, you can 
place the stamp where 
you want. 

•

Fill in the Properties.•

Digitally signed by (choose an 
available certificate in the drop-
down list). 
Make sure your certificate is 
loaded in Readiris PDF before 
using it.  If your certificate does 
not appear, restart the 
application.

•

Reason•
Location•
Contact•

Text: write text, select font color, 
background color, border color, 
border pattern, border thickness 
and opacity of the full shape.

•



Readiris PDF

                                                                                                       29 of 68 

The plus button   allows you to 
add a reply to the comment (with 
name and timestamp). Simply use 
the bin button to delete your 
comment if needed.

Watermark

Add a watermark across 
each page.

(Not visible on thumbnail 
and in multi-page view)

Markup

Add markups to words or 
sentences.

Also available with Select 
Text + Right-click

The plus button   allows you to 
add a comment to the markup (with 
name and timestamp). Simply use 
the bin button to delete your 
comment if needed

Redaction

Permanently remove 
(blacking out) sensitive 
information from your 
document.  

Click on Comments.  The 
Properties panel opens. 

•

Select a type: text or 
sticky note. 

•

Draw the box on the 
page. The text box or the 
sticky note is displayed. 

•

Fill in the Properties.•
Drag and drop the box 
where you want and 
resize it according to 
your needs.

•

Sticky note: write text, select 
border color. 

•

Click on Watermark.  
The Properties panel
opens. 

•

Fill in the Properties. •

Text to display (e.g. Confidential)•
Orientation (diagonal or 
horizontal)

•

Font type•
Font color•
Opacity slider (from 0 to 255)•
Text size slider (from 30 to 100)•

Click on Markups.  The 
Properties panel opens. 

•

Select a markup type and 
a color

•

Mouse select the word or 
sentence you want to 
markup.

•

Markup type : 
Highlight, Underline, Squiggly line 
or Strikethrough

•

Color: select a color•

Mouse select the 
sensitive text

•

Click on Redact•
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The text is blacked out 
permanently after saving. 

Also available with Select 
Text + Right-click

Attachments

Attach a file to your 
document

The file is attached on the 
current 
page. The attachment icon 

 appears.  Thanks to the 
move cursor, you can place 
the attachment where you 
want. 

Go to How to view, add or 
delete attachments for 
further explanations. 

The plus button   allows you to add 
a comment to the attachment (with 
name and timestamp). Simply use the 
bin button to delete your comment if 
needed.

Bookmarks

Add bookmarks to your 
document (PDF output)

A new bookmark is created, 
named and ordered after 
the targeted page number.

Bookmarks are visible from 
the Object Panel > 
Document 

Go to How to view, add, 
rename or delete 
Bookmarks for further 
explanations. 

 

 

Click 
on Attachments. The 
File Explorer opens.

•

Select your file to import•
Click Open•

Select the page you want 
to bookmark

•

Click on Bookmarks•
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•
•
•
•

Delete Annotations

 

Select Text + Right-click
If you mouse select some text on a page and right-click, you can access a few shortcut 
actions:

copy the selected text
highlight, underline, strikeout or squiggle the selected text (quick markup)
redact the selected text
rename the document with the selected text as title

 

 

Select the annotation you want to delete. You can do this either via the Object Panel
or directly on the page.

1

Press Delete or right-click and select Delete. A confirmation message is displayed. 2

Click Yes.3
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Edit
Edit features   allow you to enter and edit the content of your document.

 

In the Ribbon mode, go to tab Edit > Edit to find the edit features.

Some Edit features listed below require setting properties. Thus, a Properties panel
opens if applicable.  

In the Properties panel, you can modify, apply or cancel your settings

 

Icon/tooltip Description Properties

Edit Text

Text Editor.  You can edit the 
content of your document at word, 
sentence or paragraph levels.  Go 
to How to use the Text Editor for 
more information. 

Text Reflow: select a 
formatting type: 

Select:

Automatic rearranges 
automatically the edited text 
in its paragraph frame 
according to the alignment 
options. Resizing the 
paragraph automatically 
rearranges it.

•

Manual keeps the edited 
text on the same line and 
the paragraph width is 
adjusted. The Enter key 
(new line) must be placed 
manually.

•

Font and font size•
Font color•
Bold, italic•
Text alignment: left, center, 
right, justify

•
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Create Zone

Create a new recognition zone 
and associate a type to it. cf. Page 
Analysis below

The Object Panel shows you the 
new added zone.

Zone types: graphic, text or table

Analyse

Each page is divided into 
recognition zones. cf. Page 
Analysis below. 

The Object Panel shows you all the 
recognized zones on a page.  Click 
on the slide button to show/hide 
them. (Page > Zones)

When you click on a zone, the 
Properties panel opens and the 
zone type is shown. There you can 
change it. 

A zone can be moved or resized 
thanks to the move or resize 
cursor.

Zone types: graphic, text or table

Add Image

Add an 'image' to your page 

Select the page on which you 
want to create a new zone

•

Click on Create Zone•
Draw a box around the zone 
you want to define. 

•

Fill in the Properties in 
the Properties panel

•

Drag and drop the box where 
you want.  Resize it according 
to your needs

•

Select the page on which you 
want to add an image (single 
page view)

•

Click on Add Image•
In the Properties panel, open 
the file explorer by clicking on 
the 'open file' button

•

Browse and Select the image 
you want to add

•

File explorer button: browse 
for the image you want to 
use as a stamp

•
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Add Text

Add a 'text' to your page

Add Barcode

Add a 'barcode' to your page 

Go to How to add a QR code to 
have an example of use case. 

 

Click Open. The image is 
displayed in the Properties 
panel.

•

Click on the page for the image 
to be displayed

•

Drag and drop the image 
where you want. Rotate and 
resize it according to your 
needs

•

Select the page on which you 
want to add text as a stamp 
(single page view)

•

Click on Add Text•
Fill in the Properties in 
the Properties panel

•

Draw the box on the page. The 
text box is displayed. 

•

Drag and drop the text box 
where you want.  Rotate and 
resize it according to your 
needs

•

Text•
Font type•
Font size•
Font color•

Select the page on which you 
want to add a barcode (single 
page view)

•

Click on Add Barcode•
Fill in the Properties in 
the Properties panel

•

Draw the box on the page. The 
barcode box is displayed.

•

Drag and drop the barcode 
box where you want.  
Rotate and resize it according 
to your needs

•

Text: enter the value of the 
barcode

•

Type: select between QR, 
Code39, Code128, 
Datamatrix or PDF417

•
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Delete stamps

 

What is page analysis?
When you scan a document or open an image file in Readiris PDF, each page is 
automatically divided into recognition zones.

To have them displayed, go to the Object Panel and click on the slide button (show/hide). 

Readiris PDF uses those zones to determine how each part of your documents must be 
converted. If your document does not contain any zones, it cannot be recognized (OCR).

There are 3 kinds of recognition zones. You have text zones, graphic zones and table 
zones.

Each zone type has its own color.

Text blue

Image/graphic green

Table purple

 

You can also re-launch the page analysis:

 

 

Modifying the recognition zones
To change a zone type

Select the stamp you want to delete. You can do this either via the Object Panel or 
directly on the page.

1

Press Delete or right-click and select Delete. A confirmation message is displayed. 2

Click Yes.3

Click on Edit   in the icons bar or ribbon1

Click on Analyze 2

Go to the Object Panel1

Click on the slide button to show the zones. 2
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Tip: for better recognition of a logo containing text, set it as a 'graphic' 
zone type

Note: if you want to do text editing, use the Text editor.

 

 

Click on the zone for which you want to change type. The Properties panel opens 
and the zone type is shown

3

Change the zone type between graphic, text or table4
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Export documents
With Readiris PDF you can save your work under a various number of file formats, 
locally, or export it to the Cloud.  

 

Supported Output specifications

Input type Specifications

PDF versions

PDF 1.4, 1.5, 1.6, 1.7, PDF A
Extension Level 3 (AES encryption)
Extension Level 5 (XML Form Architecture)
iHQC - PDF compressed (all levels) (from I.R.I.S)

Image formats JPG, JPG2000, TIFF, BMP, PNG

MS Office formats .DOCX, .XLSX, .PPTX

Web format HTML

e-Book file format EPUB

 

Warning: For a correct image handling and processing, make sure your 
image size does not exceed 75 megapixels

Tip: For further details on the available settings per format or per 
destination, go to Configure output settings

 

Select your Output format

 

Select your Output destination

In the output area, click on Output format   . A navigation rail opens listing all the 
possible output formats

1

Select the format of your choice2

If needed, click  on the Option menu   to define the settings of your output format3

In the output area, click on Output destination  . A navigation rail opens listing 
the possible destinations

1
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Save/Save Batch

Once you are ready to export/save, click the Save button   or the Save Batch button
via the Option menu 

 

Save Batch allows you to save multiple documents in one shot with the same settings.  

The selected documents are being exported/saved.

 

Note: In the Ribbon mode, go to tab Convert to find the export 
formats and the Save/Save batch buttons.

 

Quick Convert
Readiris PDF remembers your latest output format and output destination, so that you 
can simply click the Save button if no change in your settings is needed. 

 

In the Ribbon mode, the Quick convert buttons are available from the Home tab.  
These are the shortcuts to your favorite output formats, without opening the settings 
panel.  

 

Select the destination of your choice: Local, Cloud, Email or Printer.2

Click then on the Option menu   to define the settings of your output destination3

 Click on Save batch. A pop-up window opens and list all the currently active 
documents in the workspace

1

 Select the documents you want to save/convert2

 Click OK.  3
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Configure output settings
Settings per format

 

In the Ribbon mode, go to tab Convert > Convert. When you select an output format, 
the settings panel opens. 

 

PDF

Section Option Description

Generalities PDF type

In the output area, click on Output format  .  A navigation rail opens listing all the 
possible output formats

1

Select the format of your choice2

Click on the Option menu   below the Output format button. A window opens3

Define the settings4

PDF Searchable (recognized text in 
background + original image on top 
of it)

•

PDF Image (original image only)•
PDF Text (recognized text only, 
image as graphics)

•

PDF Text/Image (image in the 
background and recognized text on 
top of it)

•

PDF Compressed (iHQC). You can 
select between 4 compression types:

•

Level I: combination of JPEG 
and TIFF CCITT4 compression

•

Level II-a: combination of 
JPEG2000 and TIFF CCITT4 
compression

•

Level II-b: combination of JPEG 
and JBIG2 compression

•
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Select a type of compression and then 
use the slider to favor either document 
quality or document size: from minimal 
document size (= high compression) to 
maximal image quality (= low 
compression).  In any case, the text 
quality is preserved. Default settings are 
Level I with medium quality. Note that if 
you select PDF 1.4/A, only PDF 
compressed level I is available. 

PDF version 13 PDF versions to choose from

Check boxes: 

Depending on the PDF type you select, 
some of these options are made 
available. 

JPEG quality  Slide from low to high (from 0 to 100)

Security

Password to open
Set a password (max. 32 characters) that 
will be required at opening of your 
document

Password to edit

Set a password (max 32 characters) that 
will be required to edit your document. 
'Password to open' and 'Password to edit' 
should be different.

Printing allowed (if password 
to edit is checked)

No per default. If yes, high resolution or 
low resolution

Changes allowed (if password 
to edit is checked)

No per default. If yes, set the change type 
you are allowing in your document (from 
a drop-down list)

Enable text access for screen 
reader devices for the 
visually impaired (if Password 
to edit is checked)

No per default. If yes, then the text can be 
read by screen readers for blind or 
visually impaired users.

Level III: combination of 
JPEG2000 and JBIG2 
compression

•

JPEG compression•
Include graphics•
Maintain colors of text•
Embed fonts•
Smoothing•
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•
•
•
•

Enable copy (if Enable text 
access is checked)

No per default. If yes, then the text can be 
copied.

Signature

Available digital IDs or certificates are 
listed in a drop-down list.  This is a global 
signature of the PDF file.  Make sure 
your certificate is loaded in Readiris PDF
before using it.  If your certificate does not 
appear, restart the application.

Metadata
Title, subject, author and 
keywords

Set metadata to provide additional 
information about your file

 

Image

Section Option Description

  Image format

  Quality slider
Set a quality level for JPEG format (in 
percentage from 1 to 100)

 

Word

Section Option Description

Generalities

Paper size
Select the paper size from a drop-down 
list (default is automatic)

Document structure:

Exact (default)
Editable
Flowing
Liquid

Exact: all detected paragraphs of text 
are placed in frames to ensure exact 
reproduction of the original document 
layout. The whole input image is 
placed in background to ensure 
maximum similarity to the original. 
This option offers less freedom for 
layout modification. 

Editable: the detected elements are 
placed in frames to ensure exact 
reproduction of the original document 

TIFF multi pages•
BMP•
JPEG•
PNG•
TIFF single page•
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layout; graphic elements are created 
to allow the layout modification. 

Flowing: the layout of the original 
pages is reproduced as closely as 
possible with body text and page 
columns, using frames only for 
elements outside of the body text.

Liquid: the layout of the original pages 
is not retained, all elements are 
written as body text in reading order.

Metadata
Title, subject, author and 
keywords

Set metadata to provide additional 
information about your file

 

Excel

Section Option Description

Generalities

Layout

2 choices:

Check boxes: 

Depending on the layout you select, 
some of these options are made 
available. Some are checked per 
default. 

Metadata
Title, subject, author and 
keywords

Set metadata to provide additional 
information about your file

 

 

Recreate source document 
(default)

•

Create body text•

Merge lines into 
paragraphs

•

Maintain colors of text•
Maintain colors of 
background

•

Convert figures into 
numbers

•

Ignore all text outside the 
tables

•

Create one worksheet per 
table

•
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•
•
•

PowerPoint

Section Option Description

Generalities Layout

3 choices:

Metadata
Title, subject, author and 
keywords

Set metadata to provide additional 
information about your file

 

HTML

Section Option Description

Generalities

Document structure:

Exact (default)
Flowing
Liquid

Exact: all detected paragraphs of text 
are placed in frames to ensure exact 
reproduction of the original document 
layout. The whole input image is 
placed in background to ensure 
maximum similarity to the original. 
This option offers less freedom for 
layout modification. 

Flowing: the layout of the original 
pages is reproduced as closely as 
possible with body text and page 
columns, using frames only for 
elements outside of the body text.

Liquid: the layout of the original pages 
is not retained, all elements are 
written as body text in reading order.

Metadata
Title, subject, author and 
keywords

Set metadata to provide additional 
information about your file

 

EPUB

Section Option Description

Generalities
Check boxes:  Per default, the three options are 

selected. 

Standard (default)•
Fit content•
Wide screen•

Include graphics•
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Metadata
Title, subject, author and 
keywords

Set metadata to provide additional 
information about your file

 

Settings per destination

 

Local 

Section Option Description

  Path Define the path to your local output folder

 
Check box: Open the file after 
creation

Check that box for the file to open straight 
after export is finished

 

Cloud

With Readiris PDF you can send documents to Box, DropBox, or OneDrive.

 

Warning: You need a valid Box, Dropbox, or OneDrive account and an 
Internet connection to be able to save your documents there.

Note: In the Ribbon mode, go to tab Share or Convert.

 

Configuring the Connectors

Maintain colors of text•
Maintain colors of 
background

•

In the output area, click on Output destination  .  A navigation rail opens listing 
all the possible output destinations

1

Select the destination of your choice: Local, Cloud, Email or Printer2

Click then on the Option menu   to define the settings of your output destination3

Once you have selected a Cloud as destination, click on the Option menu  .  A 
window opens.

1

Click on the folder icon to edit settings2



Readiris PDF

                                                                                                       45 of 68 

The configuration to your favorite Cloud accounts is persisted.  Only the authentication is 
required again when the token has expired. 

 

Email

Once you have clicked the Save button, Readiris PDF opens your default mail client for 
you to compose your email.

 

Printer

 

Follow the on-screen wizard instructions to configure your account (authentication 
and path)

3

Once you have selected the Email as destination , click on the Option menu  .  A 
window opens.

1

Enter your recipient email address and a subject2

Once you have selected the Printer as destination, click on the Option menu  .  A 
window opens.

1

Select a printer from the list2

Click on the Printer settings icon  to edit settings3
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How to obtain good recognition results?
 

The quality of the recognition results depends on a number of factors and you are 
advised to check the following points:

 

The document 
language

Make sure you select the right OCR Language in the User 
settings (ALD or Manual). Especially if your document mixes 
languages.

The quality of the 
scanned documents

If the scanned documents are too bright, or too dark, Readiris 
PDF might have trouble recognizing them.

The rotation of 
your image

Make sure the imported image has the right rotation. If not, 
use the Rotate tool in the Image processing options.

The resolution of 
your imported 
images

If you are using a scanner to scan documents, the image 
quality is also linked to the scanner settings. See the section 
Configure your scanner to make sure the right settings have 
been selected for your scanner.

Make the scan resolution is set to 300 dpi for regular 
documents and to 400 dpi for small print and Asian languages.

The recognition 
zones

see Page Analysis

 

Warning: an image of very poor quality will not be correctly recognized 
even after verification of the above points.
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•
•
•

How to do a Right Click conversion?
 

You can access some quick actions via the Right Click Menu of your Windows File 
Explorer. 

 

Caution: If you have just installed Readiris PDF, you need to restart 
before this feature is available.

 

Click Open with Readiris PDF option if you want to:

open your files directly in Readiris PDF
select another output file format
change the settings of the selected output format

 

In a File Explorer, select one or more:
image files (.tif, .tiff, .jpg, .jpeg, .bmp, .png);
PDF files (.pdf);
Microsoft Office Word documents (.doc, .docx);
Microsoft Office Excel files (.xls, .xlsx);
Microsoft Office PowerPoint files (.ppt, .pptx); 

1

Right-click and go to Readiris PDF in the menu2

Select an action:
If you selected one file only, the available actions are:

Open with Readiris PDF
Convert to PDF
Convert to Word
Convert to Excel
Convert to PowerPoint

If you selected more than one file, the available actions are:
Open with Readiris PDF
Convert to PDF
Merge to PDF

Tip: The order of your Convert or your Merge follows the 
order of your selection/clicks.

3
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How to use the Text Editor?
To enter editing mode

In the Ribbon mode, go to tab Edit > Edit section > Edit Text.

 

To edit a word, a sentence or a paragraph

 

Tip: To select text in caret navigation, you can use the keyboard shortcut 
Shift+Right or Left Arrow

 

To move or resize a paragraph

 

To change font type, font size, font color or font style

 

Go to Edit in the Icon bar 1

Click on Text  .  The Properties panel opens.2

Click in the sentence to enter caret navigation. An edition box is displayed around 
the paragraph. 

1

Edit text (add or remove characters)2

Click in the paragraph to enter caret navigation. An edition box is displayed around 
the paragraph.

1

Thanks to the move cursor, move the paragraph by dragging and dropping the box 
where you want.  

2

Thanks to the resize cursor, resize the paragraph as you want (text can stretch or 
shrink).

3

Click in a paragraph to enter caret navigation. An edition box is displayed around the 
paragraph.

1

Select the text you want to edit.2

Select the font options in the Properties panel.3
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To change paragraph alignment
Click in a paragraph to enter caret navigation. An edition box is displayed around the 
paragraph.

1

Select the alignment options in the Properties panel. The full paragraph is aligned as 
selected.

2
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How to sign a PDF document
 

Two ways of signing using digital IDs are available:

 

Sign with a stamp
 

The signature stamp is displayed in one location, but is global for the document. 

Select a PDF output format for the export. 

In the Ribbon mode, go to tab Protect > Sign section and click on IDs & Certificate.

 

Sign with the PDF output settings
 

The signature is not displayed on the document.

 

Go to Comment in the Icon bar 1

Click on Signature 2

Click on the page. Draw a stamp box. The Properties panel opens. Thanks to the 
move cursor, you can place the stamp where you want. 

3

In the Properties panel, select a digital ID available from the 'Digitally signed by' drop-
down list

4

In the Reason field, select a reason from the drop-down list or enter a new reason 
(free and optional). 

5

In the Location field, enter a location (free and optional)6

In the Contact field, enter the name of a contact (free and optional)7

Go to the Output area, and choose a PDF output format1

In the Settings, go to the Security section2

Select a digital ID available from the 'Signature' drop-down list. The signature is global 
for the document

3
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Tip: Available digital IDs or certificates are listed in a drop-down list.  
Make sure your certificate is loaded in Readiris PDF before using it.  If 
your certificate does not appear, restart the application. 
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How to view, add, rename or 
delete Bookmarks
 

View
You can view bookmarks in your document via the Object panel in the Document 
section.

The list of existing bookmarks is displayed.

When you click on a bookmark, the target page is displayed.

 

Add, Add child, Set Destination
Add

You can add bookmarks on selected pages. 

A new bookmark is created, named and ordered after the targeted page number.

If you cut/copy and paste a page, the bookmarks targeting that page are copied and 
pasted too.

In the Ribbon mode, go to tab Comment > Bookmark section > Add to add a bookmark.

In the Modern mode, go to tab Comment > Bookmarks to add a bookmark.

 

Add child

By right-clicking on a bookmark, you can also add a child to it.

Go to the Object Panel > Document1

Click on Bookmarks2

Go to the Thumbnail Panel1

Select the page you want to bookmark2

Go to the Object Panel > Document 3

Right-click on Bookmarks or on any bookmark 4

Select Add5

Go to the Thumbnail Panel1

Select the page you want to bookmark as a child2

Go to the Object Panel > Document > Bookmarks3
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A new child bookmark is created, named and ordered after the targeted page number.

 

Set destination

You can redefine the destination of an existing bookmark. 

The bookmark points to the new selected page.

 

Rename

The bookmark is renamed.

 

Delete

The bookmark is deleted.

If you delete a page, the bookmarks targeting that page are deleted too.

Caution: for the Bookmarks to be included in your exported 
documents, the output format must be a PDF.  

 

Right-click on the bookmark under which you want to add a child bookmark4

Select Add child5

Go to the Thumbnail Panel1

Select the page on which you want to set the destination2

Go to the Object Panel > Document > Bookmarks3

Right-click on the bookmark for which you want to assign the destination page4

Select Set destination5

Go to the Object Panel > Document > Bookmarks1

Right-click on the bookmark you want to rename2

Select Rename3

Enter the new name of your bookmark in the pop-up widow.  Click OK. 4

Go to the Object Panel > Document > Bookmarks1

Right-click on the bookmark you want to delete2

Select Delete3

A confirmation message is displayed. Click Yes.4
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How to view, add, comment or delete 
Attachments
 

View
You can view attachments in your document via the Object panel in the Document 
section.

The list of Attachments is displayed.

If you select an attachment, the page on which it is located is displayed. An attachment 
icon  shows you the location.

 

Add
You can add attachments to your document.

The file is attached on the current page. The attachment icon  appears.  Thanks to the 
move cursor, you can place the attachment where you want. 

In the Ribbon mode, go to tab Comment > Attachment section > File to add a file as 
attachment.

In the Modern mode, go to tab Comment > Attachments to add an attachment.

 

Comment
You can add a comment on a selected attachment.

Go to the Object Panel > Document1

Click on Attachments. 2

Go to the Object Panel > Document > Attachments1

Right-click on Attachments2

Select Add. The File Explorer opens. 3

Select your file to import4

Click Open5

Go to the Object Panel > Document > Attachments1

Select the attachment you want to comment (or select directly the attachment icon 
)

2
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A comment is added.  

Simply use the bin button to delete your comment if needed. 

 

Save

The attachment is saved.

 

Delete

OR

The attachment is deleted.

 

Caution: for the Attachments to be included in your exported 
documents, the output format must be a PDF. 

 

In the Properties panel, click on the plus button to add a comment. 3

Go to the Object Panel > Document > Attachments1

Right-click on the attachment you want to save2

Select Save3

The File Explorer opens, select the location to save the file4

Click Save5

Go to the Object Panel > Document > Attachments1

Right-click on the attachment you want to delete2

Select Delete3

A confirmation message is displayed. Click Yes.4

Right-click on the attachment icon 1

Select Delete. 2
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How to add a QR code
 

QR codes can be very handy nowadays as they can be read and understood by mobile 
devices.

Let's take, for example, the QR code 'mailto'.

 

 

The QR code is included in your document.  Anyone who scans it with a smartphone can 
easily send an email to that recipient or save it as a contact. 

 

 

Go to Edit in the Icon bar 1

Click on Add Barcode  .  The Properties panel opens2

Select type QR3

Enter an email address in the text field with prefix 'mailto:'.  Example: 
mailto:john.smith@company.com

4

Draw the box on the page. The QR code is displayed5

Drag and drop the barcode box where you want.  Rotate and resize it according to 
your needs

6

Click on Save   to export it to your favorite format (PDF, Image, DOCX, HTML 
or PPTX). 

7
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How to search and replace
 

The Search box in the title bar allows you to search and find text in the active/current 
document.  

In a second step, you can replace the found text with a new text. 

 

Search

Replace

 

Note: the searching mode does not allow selecting text. To select text, 
exit the searching mode by closing the Properties panel ( ).

 

Open the document you want to search (single-page view)1

Go to the Title bar > Search text2

Enter the text or phrase you want to locate3

Click on the Search button  or press Enter4

The search results are displayed in the Properties panel (you are now in searching 
mode). 
It shows you the number of instances and the list of results within context.  In the 
single page view, the instances are highlighted in yellow. 

5

Enter your new text in the Replace field1

Select the instance in which you want to replace text.  Click on Replace 2

To update all instances at once, click on Replace all 3
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How to automatically clean up your 
scanned images?
 

You can clean up images directly at scanning phase by setting and activating the On The 
Fly operations.   

 

 

As a result, the scanned images are already processed and cleaned up as per your 
selection of operations.  

The setting of these operations is saved and the activate/deactivate button gives you the 
flexibility to use it only when needed.  

In the input area, activate the On The Fly operations by clicking on the button 1

Click on the Option menu   (Scan settings) below the Scan button  . A window 
opens.

2

Select your scanner from the drop down list3

◦
◦
◦
◦

Select one or more image processing operations among:
Delete blank pages
Auto-rotate pages
Deskew pages
Remove black borders

Be aware however that the more operations you select, the more time the scanning 
will take.

4

Click on Scan   or press F45
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About
To find information about this software

 

 

There you find the software version and the Serial number.

Go to File Menu  1

Select Info 2
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Search for updates
 

 

OR

 

 

In the Ribbon mode, go to tab Help and click on the Updates icon. 

 

Click on Help   in the icons bar or Ribbon (tab Help)1

Click on the Updates icon 2

Go to File Menu  1

Select Update 2
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Keyboard shortcuts
Navigation
Description Keyboard Shortcut

Toggle between light theme or dark theme  
(user interface)

F11

Toggle between modern mode or ribbon 
mode  (user interface)

F12

Select multiple thumbnails or pages (multi-
page view)

Shift+Click, Shift+Up or Down Arrow 
Keys, Shift+Page Down, Shift+Page Up

Select text in text editor Shift+Right or Left Arrow keys

 

Commands
Description Keyboard Shortcut

Go to Open section in the File menu Ctrl+O

Zoom in or zoom out in the main Viewer (single 
or multi-page view) and in the Thumbnail panel

Ctrl+ mouse wheel

Cut Ctrl+X

Copy Ctrl+C

Paste Ctrl+V (per default: paste after)

Save as... Ctrl+S

Print current document Ctrl+P

Delete Del

Rename document in the tab bar F2

Open file F5
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Start scanning F4

Start exporting F9
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User Guide
 

 

OR

 

 

In the Ribbon mode, go to tab Help and click on the User Guide icon. 

Click on Help   in the icons bar1

Click on the Documentation icon 2

Go to File Menu  1

Select Help 2
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Guided Tour
 

Take a tour of the Modern User Interface.

 

Click on Help   in the icons bar1

Click on the Guided Tour icon 2
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Uninstall Readiris PDF
Should you want to remove Readiris PDF from your computer, follow the Uninstall 
instructions of your Operating System.

 

On a Windows 10 OS:

 

 

Close Readiris PDF1

From the Windows Start menu, go to Settings > Apps > Apps & features2

Select Readiris PDF from the list and click Uninstall3
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Legal Notices
 

Copyright

© 2021 I.R.I.S. SA. All Rights Reserved.

 

I.R.I.S. owns the copyrights to the Readiris PDF software, to the online help system and to 
this publication.

The software described in this document is furnished under a license agreement which 
states the terms of use of this product. The software may be used or copied only in 
accordance with the terms of that agreement. No part of this publication may be 
reproduced, transmitted, stored in a retrieval system, or translated into another language 
without the prior written consent of I.R.I.S.

Documentation version 1.3 - Product version 22.0

The information contained in this document is the property of I.R.I.S. Its content is subject 
to change without notice and does not represent a commitment on the part of I.R.I.S. Any 
modification, error correction, or feature updates made in the actual software may have 
not been timely updated in this user manual. You may refer to the software itself for 
more accurate details. Any misprints, translation error, or inconsistency with existing 
software, will be updated timely.

This manual uses fictitious names for purposes of demonstration; references to actual 
persons, companies, or organizations are strictly coincidental.

Trademarks

Readiris PDF logo and Readiris PDF are trademarks of Image Recognition Integrated 
Systems S.A. (I.R.I.S. SA)

OCR ("Optical Character Recognition"), Linguistic technology, ICR ("Intelligent Character 
Recognition") technology, MICR ("Magnetic Ink Character Recognition") technology, BCR 
("Bar Code Reading") technology, OMR (Optical Mark Recognition), iHQC ("intelligent High 
Quality Compression") technology and HQOCR ("High Quality OCR") technology by I.R.I.S.

Document Generation by I.R.I.S.

Send to the Cloud by I.R.I.S.

Windows is a registered trademark of Microsoft Corporation in the United States and 
other countries.

All other products mentioned in this documentation are trademarks or registered 
trademarks of their respective owners.
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Patent Statements

Readiris PDF integrates the following patent-granted I.R.I.S. technologies: US8068684; 
US8331706; US8666185; JP5501958; US8995780; EP2143039A2; EP14163365.1; 
BE1022166; BE1022635; US8913836; BE1022630; US8897600; BE1022636; US8811751; 
US8411940; BE1021013; US9058517; US9183636; US9311558; BE1025006; BE1022562; 
US9798943; BE1024194; US9836646; BE1024836; CN106462773B; 
CN106255979B; JP6609267; JP6693887B2; GB2571530; BE1026039; GB2572386; 
BE1026159; BE1026095.

Disclaimer

The content of this document was created and arranged with the utmost care.

I.R.I.S. SA assumes no responsibility for the accuracy, completeness and timeliness of the 
provided content.

Data privacy

We respect your privacy and take great care to protect your information. We will collect, 
process, and use any data received from you under the condition of confidentiality and in 
accordance with this Privacy Policy.

 

 

https://www.irislink.com/m1783/Privacy-Policy.aspx
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